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A Beginner's Guide to the
Genesis Framework for
WordPress

A Quick Introduction to the Genesis
Framework for WordPress

Whether you're just starting out building your Genesis site, or you need a brush-up on
where the things you need are, it can help to review the basics of how our website
framework works.

Let’s jump in with a few basic questions before moving on to the nitty-gritty...

PLEASE NOTE: if your blog is hosted on WordPress.com (mysite.wordpress.com), you
cannot install new themes. This is a restriction on WordPress.com-hosted sites.

1.1 What's a Framework?

A theme framework is a robust WordPress theme that acts as a platform on which your
WordPress website can be created. The Genesis Framework integrates all of the SEO,
security, and performance features to help you have the best site possible.
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You can build your site on the Genesis Framework using the included Sample child
theme (it's easy, flexible, and powerful enough for that), or you can purchase one of our
many beautiful turnkey child theme designs to help you accomplish exactly what you
want.

1.2 What's a Child Theme?

A child theme is a layer of code that sits on top of the Genesis Framework, comprised
mainly of the design elements of your site, but can also extend and modify the
functionality of the Genesis Framework's default functions.

The Framework + Child Theme structure of site building is great, mainly because it
separates out the performance issues of your site from the design issues. So, if you use a
child theme, you can design all day long, without ever touching the critical, underlying
code that makes Genesis sites so powerful.

Design what you want, and don't worry about bringing your site down in the process.

1.3 Theme Files

A Genesis child theme will generally be comprised, in part, of the following elements

* Screenshot -- An image of the design that the theme will create around your content.

* Style sheet (required) -- Determines the look of the site based on the HTML generated
by Genesis and WordPress.

* Functions file (required) -- Connects the child theme to the framework. Can also be
used to add, remove, and modify elements from the framework defaults.
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* home.php File (optional) -- Generally used to create a widgetized or custom home

page.
*  Other template files.
* Images (optional) -- Used by the Style sheet as a part of the site design.

These elements are grouped together in what's known as a child theme directory and can
be activated like any other WordPress theme.
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How to Install the Genesis
Framework (and a Child
Theme)

Installing the Genesis Framework and a child theme is the same process for installing any
WordPress theme, except that you're essentially installing two themes.

There are two ways to install the Genesis parent theme or a Genesis child theme:

* Manually with an FTP client (File Transfer Protocol transfers files from one host to
another).

* Automatically through the upload feature in the WordPress dashboard.

PLEASE NOTE: The Genesis Framework must be installed priorto activating a child

theme and must remain in the /wp-content/themes/ directory on your server. The
directory that contains the Genesis framework files must be named “genesis.”
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2.1 Installing Genesis from Inside WordPress

L,\"}]J Genesis [ J + New

¢} Dashboard — Help
i=m| Install Themes o

s~ Posts

3 Search | Upload Iored | Newest | Recently Updated

(5 Media

& Links
Install a theme in .zip format

[Z] Pages

If you have a theme in a .zip format, you may install it by uploading it here.

(© Comments
: o Choose File | No file chosen e

@ Premise

@ Landing Pages
@ Member Access
Scribe

Es Appearance

Themes (]
Widgets
Menus
Header
Background
Editor

£% Plugins
&, Users
T} Tools

[37] Settings

1. Toinstall a theme from inside your WordPress admin panel, mouse over the
Appearance menu item and select "Themes."
At the top of the screen, click on "Install Themes."
Click on the “Upload" link.
Using the "Choose File" button, find the zip file you previously downloaded to your
computer from the Downloads page of the members area of my.studiopress.

5. Once you have the zip file in the Choose File field, the "Install Now" button will
become active. Click the "Install Now" button.
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@ Genesis @  + New

{zt Dashboard —) t 2 A
[ Installing Theme from uploaded file: executive.zip
s# Posts S
Unpacking the package...
(4 Media
Installing the theme...
& Links
= This theme requires a parent theme. Checking if itis installed...
[Z] Pages

The parent theme, Genesis 2.0.0-RC1, is currently installed.
® t .
#® Communts o Theme installed successfully.

© Premise Live Preview | Activate | Return to Themes page

@ Landing Pages e o °

@ Member Access

Scribe

By

Themes
Widgets
Menus
Header
Background
Editor

£ Plugins

1. You will see the "Theme installed successfully" message, indicating a successful
upload.

2. "Live Preview" will display your site using the newly installed theme in a preview
mode so you can see what it would look like.

3. "Activate" will apply the newly installed theme to your live site.
"Return to Themes page" will take you to the Appearance > Themes page. Here you
can see all the installed themes.

To install a Genesis Child Theme, return to the "Install Themes" screen and repeat
steps 1-5 above.
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2.2 Installing Using FTP

If you choose to install Genesis and your child theme via FTP (or your web host’s control
panel) first unzip the theme package to your computer's desktop.

Some popular FTP programs to use for this process include CuteFTP, FileZilla, and FireFTP
for Firefox.

The four-step install:

1. Connect to your site via FTP and navigate to the themes directory (typically /wp-
content/themes/).

2. Upload the entire “genesis” directory to the themes directory. The folder name must
be “genesis” not “Genesis 2.0.” Also, there must not be any other directories before
genesis/style.css and the rest of the files.

3. Upload the entire child theme directory to /wp-content/themes/. If you are renaming
the child theme directory, avoid using special characters, including spaces.

PLEASE NOTE: if your blog is hosted on WordPress.com (mysite.wordpress.com), you
cannot install new themes. This is a restriction on WordPress.com-hosted sites.
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2.3 Activating a Theme

w“i‘ﬂ Genesis [ J
{z} Dashboard
s~ Posts

(5 Media

Twonty Ten

& Links
[C] Pages

(» Comments

@) Premise

@ Landing Pages

@ Member Access

Scribe
‘E= Appearance
|
Pt Available Themes
Widgets
Menus
Header GENERATE THEME =
Background
GET FRESH CONTENT DELIVERED (IT'5 FREE)
Editor
/& Plugins [———— |
%, Users Ewaemee jmmre) eny e
‘ﬁ‘b Tools Why Email Is the Social Media e
~ Marketing “Secret Weapon™ [~
lﬁ‘ Seﬂings T U e
Generate Child Theme
By StudioPress
Activate = Live Preview Details Delete

Help

Twenty Ten
By the WordPress team = Version 1.5

The 2010 theme for WordPress is stylish, customizable, simple, and readable — make it yours with a
custom menu, header image, and background. Twenty Ten supports six widgetized areas (two in the
sidebar, four in the footer) and featured images (thumbnails for gallery posts and custom header
images for posts and pages). It includes stylesheets for print and the admin Visual Editor, special
styles for posts in the “Asides” and “Gallery” categories, and has an optional one-column page
template that removes the sidebar.

Customize Ons: Widgets Menus Header = Background

Search Installed Themes | Feature Filter

MNIMUM THEME

GENESIS

Mobile Responsive Design

Genesis
By StudioPress

Minimum Child Theme
By StudioPress

Activate QPrevuew Details Delete

Activate = Live Preview Details Delete

1. After you have installed the Genesis Framework (and a Genesis Child Theme), activate
it by hovering your mouse over "Appearance" and select "Themes."

2. You will see a screenshot of all the available themes, including the Genesis
Framework and Genesis Child Themes you have installed. Click the "Activate" link
below the theme you want to install.

PLEASE NOTE: If you are using a Genesis Child Theme, it is not necessary to

activate the Genesis Framework theme. Be sure the Genesis Framework is

installed and activate a Child Theme.
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@) Genesis @ + New
{3} Dashboard — Help
\@\ Manage Themes

57 Posts T —

New theme activated. Visit site

(3 Media
[Z] Pages Minimum Child Theme

‘;‘ Comments By StudioPress =~ Version 2.0.1

[C] Portfolio Minimum is a two or three column child theme created for the Genesis Framework.
@ Premise This child theme requires its parent theme, Genesis.
Mobile Responsive Design ===

(@ Landing Pages Customize OPTIONS: Widgets Menus Header Background
@ Member Access

Scribe

Ec 7 Available Themes Search Installed Themes | Feature Filter
[ Genesis
—— =

Themes SV —

Widgets

Menus

Header

Background T — o GENESIS

Editor Why Email Is the Social Media

Marketing “Secret Woapon” g N 000

£ Plugins ————— e —— |

&, Users Generate Child Theme Genesis Twenty Eleven

= By StudioPress By StudioPress By the WordPress team

T} Tools

Settings Activate = Live Preview Details Delete Activate = Live Preview Details Delete Activate Live Preview Details Delete

Your Genesis Theme is activated as confirmed by the "New theme activated"

message. And the Genesis Theme displays in the "Current Theme" area.
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An Overview of the Basic
Settings of the Genesis
Framework

3.1 Theme Settings

W Genesis @@  + New

Screen Options ¥ Help v

{3} Dashboard

[T¥] Theme Settings © Reset Setings
sP Posts
Media Information o
& Links
Version: 2.0.0-RC1 - Released: TBD
Pages
(& # Enable Automatic Updates
(@ Comments
() Notify when updates are available
1;] Portfolio
If you provide an email address above, you will be notified via email when a new version of Genesis is available.
@ Premise
@ Landing Pages
@ Member Access Custom Feeds
Scribe Enter your custom feed URI:
= = 1 ") Redirect Feed?
Theme Settings Enter your custom comments feed URI:
SEO Setings ("] Redirect Feed?
Import/Export If your custom feed(s) are not byf , we do not that you use the redirect options.
Appearance
% 3
£ Plugins Default Layout
& Users
T} Tools
Settings
Navigation
(C) Load Superfish Script?
Primary Navigation Extras

Display the following: = None

o~
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1. Once your child theme is activated, you'll see a new menu item on the WordPress
Dashboard with several sub-menu options. Child themes and Genesis-specific plugins
will sometimes add additional sub-menu items, and may add additional content on
the default Genesis settings pages.

2. The Theme Settings page contains general options to control the way your theme will
behave.

3. Each of the boxes can be collapsed or expanded by clicking the box header. These
boxes can also be dragged into any order you wish, they can also be hidden by
clicking on “Screen Options” in the top right of the screen and unchecking the boxes
you don't want to see.

Let's look at each of the Theme Settings.

Information

Information

Version: 2.0.0-RC1 - Released: TBD

™ Enable Automatic Updates
Notify when updates are available

If you provide an email address above, you will be notified via email when a new version of Genesis is available.

Checking the “Enable Automatic Updates” will allow your server to check for
available updates to the Genesis Framework. No updates will be made without your

interaction. It's a good idea to leave this option enabled.
If Automatic updates are enabled, then the option to receive an email alert about the

update will be visible. Checking the box and entering an email address into the field

will result in an email being sent whenever a Genesis update is available.
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Custom Feeds

Custom Feeds

Enter your custom feed URI:
Redirect Feed?

Enter your custom comments feed URL:
Redirect Feed?

If your custom feed(s) are not handled by Feedburner, we do not recommend that you use the redirect oplions.

If you use services like Feedburner or Feedblitz to handle your RSS feed(s), you

can use this function to set your site's native feed to redirect to your custom feed.

Checking the “Redirect Feed” box will redirect all traffic to the default feed links to

the custom link instead.

If you wish to use the default feeds that WordPress generates, leave this box

empty.

Default Layout

Default Layout

07/29/2013 v2.0 studiopress.com
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This lets you select the default layout for your entire site. The following options are
available for most child themes:

* Content Sidebar

* Sidebar Content

* Content Sidebar Sidebar
* Sidebar Sidebar Content
* Sidebar Content Sidebar
* Full Width Content

Site layout options can be added or removed with custom coding in the child theme.

Child themes with a widgetized home page will often work independently of this
layout setting.

Header

Header

Use for site titleogdi A% e A 18
Image logo

You can select the option to use either “Dynamic Text,” based on the site title and
description entered in the WordPress general settings page or an “Image Logo,” set
in the Custom Header screen under the Appearance menu as the header for your
site.

The default layout option can be overridden for individual posts, pages, and custom

post types as well as category, tag, author and custom taxonomy archive pages.
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Navigation

Navigation

Primary Navigation Extras

Display the followingi A

Today's date
RSS feed links
Search form

Breaderumbs = Twitter link

By default the Primary Navigation will appear directly after the header, and the
Secondary Navigation appears below the Primary Navigation. This may vary

depending on the child theme.

In most cases the "Primary Navigation Extras" will appear on the right side of the
Primary Navigation area. Use the drop down box to select the item you want to

display, or select "None."

Breadcrumbs

Breadcrumbs

Enable on:

[ |Homepage | |Posts| | Pages| |Archives| |404 Page | | Attachment Page

Breadcrumbs are a great way of letting your visitors find out where they are on your site with just a glance. You can
enable/disable them on certain areas of your site.

07/29/2013 v2.0 studiopress.com
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Breadcrumbs are a navigation aid that allows users to keep track of their location on
a website relative to the home page. This box lets you define the pages where the

“Breadcrumbs” will be displayed.

Comments and Trackbacks

Comments and Trackbacks

Enable Comments (¥ on posts? [_| on pages?
Enable Trackbacks @ on posts? | on pages?

Comments and Trackbacks can also be disabled on a per postjpage basis when crealing/editing posts/jpages.

Genesis allows you to globally enable or disable Comments and Trackbacks on
Posts and Pages. If Comments or Trackbacks are disabled here they cannot be

enabled on an individual post or page basis.

You'll find more information about Trackbacks here.

07/29/2013 v2.0 studiopress.com 17
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Content Archives

Content Archives

Select one of the followindR A sl A L Qe Cl

Display post excerpts

Limit content to characters

Using this option will limit the text and strip all formatting from the text displayed. To use this option, choose "Display post
content" in the select box above.

™ Include the Featured Image?

Image Size: large (1024 x 1024) s

Select Post Navigation Technique: Older /Newer &

These options will affect any blog listings page, including archive, author, blog, category, search, and tag pages.

In the Genesis Theme Settings you may change the site-wide Content Archives
options to control the way content displays on category, tag, author date, and

taxonomy archive pages.

The first option allows you to display the post content or the post excerpt.

The “Display post content” setting, if used, will display the entire post including
HTML code up to the location of a <!-- more--> tag, which is an HTML comment tag

and will not be visible to visitors.

Using the, “Limit content to | | characters,” option it is possible to limit the content
to a specific number of letters and spaces. This option will strip any HTML from the
content, but it allows for more precise control over the length of the post content that

is displayed on the archive pages.
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The “Display post excerpts” setting will display the first 55 words of the post, also
stripping any included HTML. If a manual excerpt is set in a post it will be displayed
in place of the first 55 words of the post content.

The “Include the Featured Image?” setting allows you to show a thumbnail of the
first attached image or the currently set featured image for the post. [Note: to avoid
displaying duplicate images, this option should not be used when displaying full post

content.]

The “Image Size” list is populated by the available image sizes defined in the
theme.

“Select Post Navigation Technique” allows you to select one of three navigation
display methods: Older/Newer, Previous/Next and Numeric. These navigation links
will be visible on category, tag, author date, and taxonomy archive pages, pages

using the blog page template, and on blog style home pages.

Blog Page Template

Blog Page Template

These settings apply to any page given the "Blog" page template, not the homepage or post archive pages.

Display which category: All Categories %

Exclude the following Category IDs:

Comma separated - 1,2,3 for example

Number of Posts to Show: 10

07/29/2013 v2.0 studiopress.com 19
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The Blog Page Template settings govern pages using the Blog Template. A page
that is set to use this template will display a list of recent posts similar to the home
page view of a blog style home page.

In the General Settings you can select a specific category to display from the drop
down menu. You can exclude categories by ID, as well as select how many posts

you'd like to display on this page.

PLEASE NOTE: A page using blog page template should not be used as a static
home page.

Header and Footer Scripts

Header and Footer Scripts

Enter scripts or code you would like outputto wp_head() :

The wp_head() hook executes immediately before the closing </head> tag in the document source.

Enter scripts or code you would like outputto wp_footer() :

The wp_footer() hook executes immediately before the closing </body> tag in the document source.

07/29/2013 v2.0 studiopress.com
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The header and footer script text areas will allow you to add coding for tools such as
statistics tracking and other code that 3rd party services require to be added to the
header or footer area of your site. One notable example would be the code for

Google Analytics tracking which can be added to the header scripts box.

3.2 SEO Settings

(ﬂ Genesis ® 4 New

(3} Dashboard Screen Options

[T7 Genesis - SEO Settings Rl | Reset Settings
s Posts ——
Media Doctitle Settings
@2 Links

The Document Title is the single most important SEO tag in your document source. It succinctly informs search
@ Pages engines of what information is contained in the document. The doctitle changes from page to page, but these options
will help you control what it looks by default.

~) Comments
Q By default, the homepage doctitle will contain the site title, the single post and page doctitle will contain the post/page
@ Premise title, archive pages will contain the archive type, etc.
@ Landing Pages 4 Append Site Description to Doctitle on homepage?
Scribe Append Site Name to Doctitle on inner pages?
Doctitle ( <title> ) Append Location:
G Genesis A( 8 ) Pe 2 ;s g
Determines what side the appended doctitle text will go on.
Theme Settings
SEO Setti Lo
ngs @ Right
Import/Export
README Doctitle ( <title> ) Separator: —
Slider Settings If the doctitle consists of two parts (Title & Appended Text), then the Doctitle Separator will go between them.
Appearance
Homepage Settings
£ Plugins pag &
A Users .
= Document Head Settings
T} Tools
Settings Robots Meta Settings
Archives Settings
CEVERTNE  Reset Settings
Thank you for creating with WordPress. You are using a development version (3.5.3-alpha). Cooll Please stay updated.

When Genesis SEO (search engine optimization) is active, you will see the General
SEO settings for your site. If any of several Advanced SEO plugins are active the

07/29/2013 v2.0 studiopress.com 21


http://studiopress.com

— A Beginner’s Guide to the Genesis Framework for WordPress —

Genesis SEO settings will be automatically disabled to avoid duplicate SEO related
fields from being displayed for your site.

The default settings are recommended for most users. For more specific information
about the Genesis SEO settings please check out this tutorial.

3.3 Import/Export

@ (Genesis @  + New

{z} Dashboard ~=af . Help
[ () Genesis - Import/Export

s~ Posts =

3y Media Import Genesis Settings File Upload the data file ( .json ) from your computer and we'll import your settings.

5:* Links Choose the file from your computer and click "Upload file and Import*

[C] Pages [ Choose File | No file chosen Upload Flle and Import

(@ Comments

© Premise Export Genesis Settings File When you click the button below, Genesis will generate a data file ( . json ) for you to save to
@ Landing Pages your computer.
@ Member Access Once you have saved the download file, you can use the import function on another site to
. import this data.
B4 Scribe :
. _| Theme Settings
S . [ SEO Settings
Theme Settings
SEO Settings Fle
Import/Export

[5] Appearance
£ Plugins

& Users

T} Tools

Settings

The Import/Export option allows you to import or export Genesis Settings for use as
a backup or on a different site.
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This is specific to Genesis settings and does not include a backup of your posts,

pages, or images, which is what the built-in WordPress import/export feature does.

The Genesis export feature also does not include settings for plugins, widgets, or
specific settings related to posts, pages, terms, or users.

07/29/2013 v2.0 studiopress.com

23


http://studiopress.com

— A Beginner’s Guide to the Genesis Framework for WordPress —

Configuring the Home Page
of Your Genesis Site

4.1 Custom Home Page

Many Genesis child themes available from StudioPress include a custom home page.

‘u';‘w Genesis
(&} Dashboard
s~ Posts
Media
2 Links
[C] Pages
(® Comments
iCll Portfolio
@ Premise
(@ Landing Pages
(@ Member Access
Scribe
[@ Genesis
[E5) Appearance
£ Plugins
& Users
T4 Tools

General
Writing
Reading
Discussion
Media
Permalinks

07/29/2013 v2.0

+ New

[T¥] Reading Settings

Front page displays

Blog pages show at most

Syndication feeds show the most

recent

For each article in a feed, show

Search Engine Visibility

Help

@Your latest posts
ge (select below)

Frontpage: — Select —

«

Posts page: — Select —

<«

10 % posts

10 (% items

(®)Full text
() Summary

("I Discourage search engines from indexing this site

Itis up to search engines to honor this request.
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To use this type of home page, make sure your latest posts are set to show on the
front page at Settings > Reading. You can set up a page with the Blog page

template to show a blog style list of your latest posts on another page.

W Genesis
{3} Dashboard

s» Posts

(5 Media

& Links

[E] Pages

(@ Comments

IC] Portfolio

© Premise

(@ Landing Pages
(@ Member Access
Scribe

Genesis

Themes
Widgets
Menus
Header
Background
Editor

£ Plugins
& Users
Ti Tools

Settings

The home page will often include Home Page widget areas that are registered by
the child theme. These areas can be configured from the Widgets screen via

+ New
B Widgets

Available Widgets

Drag widgets from here to a sidebar on the right to activate them.
Drag widgets back here to deactivate them and delete their

settings.

Archives

A monthly archive of your site's posts

Calendar

A calendar of your site's posts

Categorles

Alist or dropdown of categories

Custom Menu

Use this widget to add one of your custom
menus as a widget.

Genesis - Category Menu

This widget has been deprecated, and will
eventually be removed. DO NOT use it.
You have been warned.

Genesis - eNews and Updates

Displays Feedburner email subscribe form

Genesis - Featured Page

Displays featured page with thumbnails

Genesis - Featured Posts

Displays featured posts with thumbnails

Genesis - Latest Tweets

Display a list of your latest tweets.

Genesis - Page Menu

This widget has been deprecated, and will
eventually be removed. DO NOT use it.
You have been wamed.

Genesis - Responsive Slider

Displays a slideshow inside a widget area

Genesis - User Profile

Displays user profile block with Gravatar

Links

Your blogroll

Appearance > Widgets.

07/29/2013 v2.0
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Screen Options v Help *

Header Right

Primary Sidebar

Home - Slider
This is the slider section on the home page.

Genesis - Responsive Slider

Home - Top
This is the top section of the home page.

Custom Menu

Search

Home - Call To Action

This is the call to action section on the home
page.

Text

Home - Middle
This is the middle section of the home page.

Genesis - Featured Page

Genesis - Featured Page

Genesis - Featured Page

Footer 1

Footer 2

Footer 3
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Child themes that include this type of home page typically include additional theme-
specific tutorials. These can be accessed in the Member's Area at

my.studiopress.com under the "Get Started" link.

4.2 Blog Home Page

Another common home page is the “Blog” style home page. This shows your latest posts
on the home page and requires no additional setup for most of our newer themes.

If your theme does not default to a blog style home page and uses a custom home page
but you would prefer to display the latest posts in a blog format, do not use the blog
template. Instead, you should rename the home.php file to home-old.php via FTP or a
web based file manager provided by your host.

4.3 Dynamic Home Page

The third type of home page is the dynamic home page, which is common on the newest
child themes. It includes widgets to add content to the home page, but will show your
latest posts in a blog style listing if you do not add content to the home widgets.

This setup is preferred because it makes it easier to show a blog on the front page (no

need to rename the home.php file) and does not have the confusion of no content on the
home page when the theme is initially installed.
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4.4 Static Home Page

Some users would prefer to display the contents of a single, static page on the home
page.

@ Genesis ® + New

(3 Dashboard Help

[I7| Reading Settings

s~ Posts
% Medi Front page displays
1a
& Links (®)A static page (select below)
Pages Frontpage: Home :

(@ Comments Posts page: = Blog :

iC]| Portfolio

@ Premise Blog pages show at most 10 3] posts

@ Landing Pages Syndication feeds show the most 10 1) items

@ Member Access recent

Scribe For each article in a feed, show @ Fulltext

(_)Summary
[ Genesis

[E5] Appearance Search Engine Visibility @ Discourage search engines from indexing this site
),@ Plugins Itis up to search engines to honor this request.

J;g Users
Tj Tools

General
Writing
Reading
Discussion
Media

Permalinks

This can be accomplished by creating and publishing a Page in the WordPress
admin panel and then setting the home page to display that page as the home page
in the option found on the Reading Settings page.
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How to set up a Menu

5.1 Creating a Menu

Genesis uses the WordPress custom menu feature. Once you have published some pages
and posts, you are ready to create a menu.

{3} Dashboard — Screen Options ¥ Help v
[ET Menus
57 Posts Social Top
Media Theme Locations Menu Name Top
Pages () Automatically add new top-level pages
E;l 9 Your theme supports 2 menus. Select which oz v P pag
@ Comments menu appears in each location. Delete Menu Save Menu
Genesis Primary Navigation Menu
Top 5
e ;
Secondary Navigation Menu Home age
Themes Social 2
Widgets Blog Page
e
Header o
P
Background Ll age
Editor Custom Links
Specials Page
£ Plugins URL http://
48 Usars Label Menu ltem Place Order Page
T} Tools
o Add to Menu
Settings About Page
Pages Privacy Policy Page
Most Recent  View All  Search
Sitemap Page
[_JHome
(] Recipe Pi
(JBlog Media age
] Seasonal Special
[ Place Order Contact Us Page
[CJMedia
(C) Sitemap
[_) Privacy Policy
[_JContact Us
[_)Menu Suggestions o Save Menu
Select All o Add to Menu
Posts
MostRecent View All  Search
[_) Another Blog Post
(C] This is a blog post
Select All o Add to Menu
Thank you for creating with WordPress. Version 3.5.2
07/29/2013 v2.0 studiopress.com
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Mouse over "Appearance" and select "Menus."

Click on the + symbol to create a new Menu.

Add a "Menu Name."

Add a check mark in the box next to "Automatically add new top-level pages" and
they will be automatically added to the menu. Leave the box unchecked to manually
add new pages to the menu.

To add a "Custom Link" to the menu, add the "URL" and the "Label" that will be used
for the link. Click the "Add to Menu" button.

Add "Pages" to your menu by adding a check mark to the pages you want to add and
click the "Add to Menu" button.

Add "Posts" to your menu by checking the appropriate box and click the "Add to
Menu" button.

All of the links you added to the menu will appear in a list. Click and drag the boxes to
change the order of the menu items. You also can create a sub navigation menu item
by moving a box so it is indented to the right of all the other boxes.

Be sure to click the "Save Menu" button to save your menu.

. If this menu will be used as your "Primary Navigation," select it in the drop down box

and click the "Save" button. You may see a "Secondary Navigation" menu depending
on your theme. Just create another menu following these same steps and select the
new menu as the Secondary Navigation.
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& ® o+ New

3
St Show on screen

57 Posts @ Theme Locations @ CustomLinks o Posts ™ Pages © Categories & Tags
(5 Media Show advanced menu properties
@ Pages |_J Link Target _| CSSClasses | _| Link Relationship (XFN) _| Description

(@ Comments

[@ Genesis ‘Eij‘ Menus
To
P
THames Theme Locations Menu Name Top [C] Automatically add new top-level pages
Widgets Your theme supports 2 menus. Select which Deleta Menu Save Menu
Menus menu appears in each location.
Header Primary Navigation Menu
Background Top N
Editor Home
//@ Plugins Secondary Navigation Menu
Sacial v Blog
4 Users
=3
T} Tools Menus Page
[2%] Settings
Custom Links Specials Pagia
URL http://
Place Order Page
Label
About Page

Add to Menu

If you do not see all of the menu options available, for example,

the box of Posts

does not appear, click the "Screen Options" link and add a check mark next to the

missing item. When you are done, click the "Screen Options" link again to minimize

the feature.
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5.2 Creating a non-clickable Menu Item

Custom Links
UAL #
Label About

Add to Menu

You may want to have a top-level menu item that is not clickable. Just add a
"Custom Link" and use # for the "URL" and add your link "Label."
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How to Use Genesis Widgets

Most Genesis child themes will include at least three Widget Areas (AKA Sidebars).

(W Genesis L J + New

(3} Dashboard — g Screen Options Help
|B Widgets
s~ Posts
Media Available Widgets o Header Right
& Links Drag widgets from here to a sidebar on the right to activate them. s s :
Drag widgets back here to deactivate them and delete their settings. This Is the widget area in the header.
] Pages

Archives :
@ Comments CustomMenu v __________..

A monthly archive of your site's posts
@© Premise

@ Landing Pages Calendar o Pri Sidebar
Tim: el
@ PR A calendar of your site's p L.
. This is the primary sidebar if you are using a
Scribe Categories two or three column site layout option.

A list or dropdown of categories

. Genesis - User Profile
Themes Use this widget to add one of your custom Genesis - Featured Page
menus as a widget.
Widgets
M Genesis - Featured Posts
i Genesis - Featured Page
Editor
Displays featured page with thumbnails
£ Plugins
Secondary Sidebar
& Users Genesis - Featured Posts o g
Tt Tools Displays foaturad posts with inumbnaiis This is the secondary sidebar if you are using
a three column site layout option.
Settings Genesis - User Profile

Widgets can be configured from the Appearance > Widgets page of the WordPress

admin panel.

1. Header Right (displays on the right side of the header; put a widget in the widget area
to activate it)

2. Primary Sidebar (displays next to the Content; it is enabled in all layouts except Full
Width Content)

3. Secondary Sidebar (displays next to Content or Primary Sidebar; it is enabled only in
two sidebar layouts such as Sidebar Content Sidebar)
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Many child themes will add additional sidebars. These can often be displayed on

the home page, the footer, or in various other locations depending on the child

theme.

More general information about managing widget areas can be found right here.
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What Widgets Are Included
with the Genesis Framework?

7.1 Genesis -- Featured Page Widget

To add the Featured Page widget to your sidebar, go to Appearance > Widgets in your
WordPress dashboard.

There you will see the “Genesis Featured Page” widget as an available widget. Click and
drag to place it in the widget area of your choice. You can use this widget as many times
as you like, with different configurations in each instance of the widget.

Genesis - Featured Page

Title:

Page:

4

|_| Show Featured Image

Image Size: thumbnail (150x150) %

Image Alignment: -None- %

|_I Show Page Title

|_| Show Page Content
Content Character Limit:

More Text:

Delete | Close
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Here is what each option included in the widget interface does:

* Title -- the title of the widget.

* Page -- the page you want to display.

* Show Featured Image -- shows the image designated as the featured image for the
page.

* Image Size -- depending on your child theme, a variety of sizes will be available.

* Image Alignment -- allows you to display the image to the left or the right of the
content.

* Show Page Title -- displays the title of the page.

* Show Page Content -- shows the complete content of the post, including images
(not recommended if you have large images in the post content). Use the “More”
button to split post content. Everything above the “More” will display in the widget.

* Content Character Limit -- use this to avoid having to use the “More” button. Set the
number of characters from the beginning of the post you want to be shown in the
widget. This will remove HTML formatting.

* More Text (if applicable) -- add the text that will link to the rest of the page content.

Be sure to click the "Save" Button to save your widget settings.

7.2 Genesis -- Featured Posts Widget

To add the Featured Posts widget to your sidebar, go to Appearance > Widgets in your
WordPress dashboard.

There you'll see the “Genesis Featured Posts” widget as an available widget. Click and

drag it into the widget area of your choice. You can use this widget as many times as you
like, with different configurations in each instance of the widget.
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Genesils - Featured Posts

Title:

Category: All Categories * | Show Post Title

("] Show Post Info

Number of Posts to Show: 1 [post_date] By [post_author_posts_link] [

Number of Posts to Offset: 0 Content Type:  Show Excerpt N

Order By: Date Limitcontentto 0 characters

<

More Text (if applicable):

Sort Order: Descending (3,2,1) &
[Read More...]

[_| Exclude Previously Displayed Posts?

To display an unordered list of more posts

(") Show Author Gravatar from this category, please fill out the
information below:

G A
Gravatar Size: Small (45px) v Title:

Gravatar Alignment: - None- %

Number of Posts to Show:

() Show Featured Image

Image Size: thumbnail (150x150) ¢ ke Show Gategon/ Arohive Link

Link Text:
Image Alignment: -None- % More Posts from this Category

Delete | Close

Here’s what each widget option does:

* Title -- the title of the widget.

* Category -- you can display posts from all categories, or just from one specific
category.

*  Number of Posts to Show -- how many posts to display.
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Number of Posts to Offset -- this is useful when you want to have one or more posts
displayed in full on the main portion of your page and plus others displayed below.
Offsetting by the number of posts in the main area means that only distinct content
will show in the widget.

Order by -- choose from: the Date on the post; the Title of the post in alphabetical
order; Parent, useful when you are displaying all categories - keeps your posts
grouped by category; the ID, the order in which the posts were created; Comment
Count shows those with the most comments; and Random order.

Sort Order -- choose either Descending (3, 2, 1) or Ascending (1, 2, 3).

Exclude Previously Displayed Posts - check this box if you would like to exclude
posts that are displayed elsewhere on the page, for example, in a slider widget.
Show Author Gravatar -- for this to display, the author must have a gravatar from
http://gravatar.com associated with the email address in his profile. With this option
you can set the Gravatar Size and choose if the image should be aligned to the left or
right of the text.

Show Featured Image -- this will display the first image uploaded to the post as a
150 x 150 thumbnail. For this option to work, you don’t have to actually display the
image in the post or use a custom field. As with the Author Gravatar, you can choose
to place this image on the left, right, or above the text.

Show Post Title -- displays the title of the post.

Show Post Info -- this is the post meta info (Date, Author, and a link for the visitor to
comment).

Content Type -- options are "Show Content "- shows the complete content of the
post, including images (not recommended if you have large images in the post
content). Use this if you want to show an excerpt of the post that contains images and
HTML, using the “more” button within the post to designate the stopping point (i.e.
everything above the “More” will display in the widget); "Show Excerpt"- a teaser that
refers to the first 55 words of the post's content. All HTML tags and graphics are
stripped from the excerpt’s content; "Show Content Limit" - similar to showing an
excerpt, but you can define the exact amount of characters; and "No Content" - hides
all content and only displays Title/Byline.

Limit content to -- use with the "Show Content Limit" above; functions just like the
excerpt, but gives you more control over the number of characters shown.
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* More Text (if applicable) -- links to the rest of the post’s content with specified text,
typically “Read more.”

* Unordered List of Posts -- this will display just the titles of additional posts from the
category or categories chosen, and will automatically exclude the posts already
shown above the list.

* Title -- used with the Unordered List of Post above, enter a Title that will display with
the list.

*  Number of Posts to Show -- used with the Unordered List of Post above, enter the
number of posts to include in the list.

* Show Category Archive Link -- if only one category is selected for the widget, use
this to display a link to the archive page for that category.

* Link Text -- anchor text that will display on the page to link to the rest of the
category’s content.

Be sure to click the "Save" Button to save your widget settings.

7.3 Genesis -- User Profile Widget

To add the “Genesis - User Profile” widget to your sidebar, go to Appearance > Widgets in
your WordPress dashboard. There you will see “Genesis User Profile” as an available
widget. Click and drag to move it into the widget area of your choice.
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Genesis - User Profile

Title:

Select a user. The email address for this
account will be used to pull the Gravatar

image.

Author v
Gravatar Size: Small (45px) =
Gravatar Alignment: = Left B

Select which text you would like to use
as the author description

() Author Bio

(") Custom Text (below)

4

Choose your extended "About Me" page
from the list below. This will be the page
linked to atthe end of the about me
section.

None

ar

Extended page link text:
Read More...

() Show Author Archive Link?

Delete | Close

Here is what each option in the widget interface does:

* Title -- the title of the widget.

* Select a User -- select the user who will be identified.

* Gravatar Size -- the size of the user’s Gravatar image that will display.

* Gravatar Alignment -- display the Gravatar to the left or the right of the text.
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* Author Description Text -- you can choose to pull the "Author’s Bio" from the user’s
Biographical Info (located in the “About Yourself” section on the user’s page in the
dashboard) or you can type in "Custom Text" to display as the Author Description.

* Extended About Me Page -- choose a page that will be linked to at the end of the
Author Description to provide more information about the Author.

* Extended Page Link Text -- the text to use to link to the Extended About Me page.

* Show Author Archive Link -- displays a link to a page that contains links to all pages
associated with the Author.

Be sure to click the "Save" Button to save your widget settings.

7.4 Additional Widgets

Some child themes may include additional widgets or require the use of plugins with
additional widgets.

Please see the setup tutorials for your child theme to see theme-specific instructions.
These are located in the my.studiopress.com Member's Area under the "Get Started" link

next to your theme download.
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How to Use Your Own Logo
or Header Image on Your
Genesis Site

Currently there are two basic ways of interacting with the logo/header, depending on
your child theme. You will either find the Header Settings under the Appearance menu,
or it will be on the Genesis > Theme Settings screen.

8.1 Genesis > Theme Settings

Header

Use for site title/og QR % LUl [ {44

Image logo

In the Genesis > Theme Settings you will have a “Header Settings” box where you

can select to show the “Image Logo” or “Dynamic Text” logo.

The dynamic text will show the site title and description from the "General Settings"
in your WordPress dashboard. If you select “Image Logo,” it will show the logo.png
file from your theme images directory. (Note that in a few themes this may change

the header.png file instead). The text will be hidden using an SEO-friendly text

replacement technique.
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To change your image logo, you need to access your site via FTP and navigate to
the child theme images directory, for example: /wp-content/themes/child-
theme/images. Once there, replace the default logo.png file with your own logo

image that you have named logo.png.

8.2 Appearance > Header Settings

“\\';‘u Genesis L + New

(3} Dashboard Help

B0 Custom Header

s~ Posts
3 Header Image
55 Media
& Links Preview
Genesis
Pages
(@ Comments
iC]l Portfolio
@© Premise Select Image You can select an image to be shown at the top of your site by uploading from your
Landing P computer or choosing from your media library. After selecting an image you will be able to
& Landing Pages
€ S crop it.
@ Member Access Images of exactly 1140 x 100 pixels will be used as-is.
Scribe Choose an image from your computer:

| Choose File | No file chosen

Genesis o
Or choose an image from your media library:
Appearance
Choose Image
Themes

Widgets
Remove Image This will remove the header image. You will not be able to restore any customizations.

Menus

Header Remove Header Image
Background

Editor Header Text

= :
& Plugins Header Text o @ Show header text with your image.

& Users
T} Tools TetGoge Il st corr

[9] Settings

Couw craroes J 2

1. If you have the "Header" menu item under "Appearance,” click on this menu item.
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2. Upload the header image using the “Choose File” button. The dimensions that should
be used for your header image are shown on the screen. For best results be sure that
your image is the indicated size prior to uploading to avoid cropping. If you only want
to use a small logo on the left side, then create an image on a blank canvas set to the
same height and width specified in the Header page. Save this as a png file with a
transparent background and upload. If you get a black background, verify that the file
is exactly the same height and width indicated.

3. The Header page also includes an option to display the header text. This will show or
hide the site title and description based on the setting you choose.

4. Don't forget to click the "Save Changes" button.

PLEASE NOTE: References to a "Header" usually refer to the header area that is
the full width of the content. The "Logo" usually refers to a smaller graphic within the
header area.
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How to Use Genesis

Templates

9.1 Setting a Page Template

‘C‘?w Genesis @@ -+ New
(&} Dashboard =
| Add New Page
s~ Posts
Media
& Links

All Pages B I e EE 2; & = = =
Sikic Paragraph v U = A ~ [@ [
(© Comments

iCll Portfolio

@ Premise

@ Landing Pages
@ Member Access
Scribe

Genesis

[E0) Appearance

£ Plugins

&, Users

Tf Tools

Settings

Visual

=
=

Text

Screen Options Help
Publish
Save Draft Preview
Status: Draft Edit
Visibility: Public Edit
[ii] Publish immediately Edit
Move to Trash Publish

Page Attributes

Parent

<«

(no parent)
Template

v Default Template

Archive
Blog
Landing
e —

Need help? Use the Help tab in the upper right
of your screen.

A WordPress page (not a post) can be configured to use a template by selecting an

available template option on the edit screen right sidebar under “Page Attributes.”
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Some themes may include additional templates. Refer to the child theme specific
tutorials for details on using additional templates in the Members Area of

my.studiopress.

9.2 Blog Template

The Blog page template shows the latest posts in a blog list format.

w\";\» Genesis [ 4+ New View Page

- Edit Page dsne

(&} Dashboard Screen Options Help

57 Posts
gy Media o Blog Publish
& Links Permalink: hitpZ//premise katybarrilleaux.com/blog/| Edit || View Page Preview Changes
I8 Pages (53 Add Media Visual Text Status: Published Edit
All Pages o— 1— R —
ge B I ae 5= - « == = Es.828 Visibility: Public Edit
Add New - .
— Paragraph v U = A~ @ W @ Q bt @ 3] Published on: Jul 22,2013 @ 14:54 Edit
(© Comments
O Porttalio 0 Move o Trash o
© Premise
(@) Landing Pages Page Attributes
Scribe Parent
[d Genesis (no parent) =
[E0] Appearance Template
£ Plugins o Blog 4
& Users Order
T} Tools 0
[I7] Settings Need help? Use the Help tab in the upper right
of your screen.
Path: p
Word count: 0 Last edited by John Doe on July 22, 2013 at 2:54 pm

1. To set up a blog page, start by giving the page a title.
2. Inthe "Page Attributes" box along the right hand side, use the drop down box to
select "Blog" under "Template."
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3. You will leave the content blank. The template will autopopulate the page with your
blog post list.
4. Click the "Publish" button.

Add the page to a Navigation menu in order to display the link to your new blog

page.

9.3 Archive Template

The Archive template creates a sitemap of your site.

\T}, Genesis [ J 4+ New View Page

(3} Dashboard Screen Options Help

[Z| Edit Page adinew

s Posts
Media Sitemap Publish
;' Links Permalink: http//premise katybarrilleaux.com/archive/| Edit || View Page Preview Changes
All Pages o— [1= = .= o
ge B I = =|i=|« = = = =R N Visibility: Public Edit
Add New ~ .
Paragraph v U = A~ [@ @ @ Q = © 3] Published on: Jul 22,2013 @ 20:50 Edit

(® Comments

|C]| Portfolio Move to Trash

@ Premise

@ Landing Pages Page Attributes

Scribe Parent

[@ Genesis (no parent) s
[T Appearance
/& Plugins

&, Users

T} Tools 0

[27] Settings Need help? Use the Help tab in the upper right

of your screen.

Set up an Archive template page in the same manner as a Blog template page. Like
the Blog template, the content of a page using the Archive template will be

generated dynamically based on the content of your site.
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The ABC’s of Updating the
Genesis Framework

10.1 Using the Automatic Update

Before you update Genesis, make sure you have backup copies of your child theme and

your current version of Genesis as a precaution.

)

\

Genesis

¢y Dashboard Genesis 2.0.0-RCH1 is available. Check out what's new or update now.

Home /AN
ST {5 Dashboard

5P Posts Right Now

Media Content Discussion
& Links 20 Posts O Comments
[C] Pages 20 Pages O Approved
@ Comments 1 category O Pending
@ Premise 44 Tags O Sewn

@ Landing Pages Theme Genesis with 2 Widgets

To begin the update process, click the “update now” link in the update notification at

the top of your dashboard page.

Confirm the update.

After the new version is installed, click the link to complete the update. You will be

redirected to the Genesis settings page. All done!
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PLEASE NOTE: If the “update now” link is not displaying, enable it by going to the
Genesis Options section of your dashboard: Genesis > Theme Settings >
Information and click on the “Enable Automatic Updates” checkbox.

When updating Genesis on a multi-site installation of WordPress visit the Genesis
settings screen of each site to ensure that any necessary database updates are

completed.

10.2 Updating Manually

1. Before you update anything, make sure you have backup copies of your child theme
and your current version of Genesis as a precaution.
Download and extract the zip file to your computer and note it’s location.
Delete the old genesis directory from your /wp-content/themes directory via FTP.
Upload the new, unzipped genesis directory to your /wp-content/themes directory
from your computer to your web server via FTP.

5. Loginto the dashboard and visit the Genesis settings screen to complete the update
process.

PLEASE NOTE: If you have made any changes directly to files in the /genesis/ directory,

updating will overwrite these changes. We strongly recommend that you NEVER make
changes this way.
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A Few Useful Additional
Resources

11.1 Plugins

One great thing about Genesis is that it's been designed to be extended to almost any
need you might have with plugins.

Here's a set of very user-friendly plugins to help you customize your site.

0’.‘ Genesis » + New

¢4} Dashboard v : Screen Options Help
¥ Install Plugins

57 Posts
Search | Upload | Featured | Popular | Newest | Favorites

Media

@,@ Links Plugins extend and expand the functionality of WordPress. You may automatically install plugins from the WordPress Plugin Directory or
upload a plugin in .zip format via this page.

[E] Pages

© Comments Search

@ Premise o genesis responsive slider Search Plugins

@ Landing Pages
Popular tags
@-',“ Member Access You may aiso browse based on the most popular tags in the Plugin Directory:

Scribe

[@ Genesis

D) Appearance POStS rss seo smae Shortcode sidebar social spam stats twitter video Wld et widgets

Installed Plugins
Add New
Editor

&, Users
T} Tools
Settings

07/29/2013 v2.0 studiopress.com 49


http://studiopress.com
http://www.studiopress.com/plugins

— A Beginner’s Guide to the Genesis Framework for WordPress —

1. Toinstall these plugins through your WordPress dashboard, visit the Plugins menu
and click the “Add New”
2. Use the "Search" feature to search for the plugin title.

({‘ Genesis » + New

(& Dashboard Ay : Screen Options Help
£Z Install Plugins

s~ Posts
Search | Search Results | Upload | Featured | Popular | Newest | Favorites

5 Media
2 Links Keyword % genesis responsive slider Search Plugins 7 items
[C] Pages Name Version Rating Description
(.A-?' Comments " Genesis > This plugin allows you to create a simple responsive slider that displays the

5 Responsive Slider featured image, along with the title and excerpt from each post.
©) Premise Itincludes options for the maximum dimensions of your slideshow, allows you to

Details | Install Now
choose to display posts or pages, what category to pull from, and even the

specific post IDs of the posts you want to display. It includes next/previous arrows
and a pager alon... By StudioPress.

(@ Landing Pages

(@ Member Access

Genesis Toolbar 16.0 3.7 57 57 57 77 Quick Access to Genesis Framework Resources - Time Saver!
Scribe Extras This plugin just adds a lot Genesis Framework related resources to your toolbar /
Details | Install Now admin bar. Also links to all settings pages of this framework are added making
[@ Genesis life for webmasters a lot easier. So you might just switch from the frontend of your

site to the Genesis Theme Settings' or adjust additional extensions like 'Genesis
Simple Hooks... By David Decker - DECKERWEB.

[E5] Appearance
Genesis Bootstrap 0.1.2 4 She S Note: This plugin only supports Genesis child themes. If you don't know what that

Carousel I is, don't download this plugin.

Details | Install Now Genesis Bootstrap Carousel (GBC) allows you to create a simple responsive

Installed Plugins image carousel that displays the featured image, along with the title and excerpt
Add New from each post.
Editor GBC is based off of the Genesis Responsive Slider and uses a lot of the same

code. The main difference is that th... By jtallant.

When you locate the plugin, click the "Install Now" link and follow the instructions on

screen to install the plugin.

And here's a short description of just a few of our own Genesis plugins, and what

they can do for you...

Genesis Simple Edits

This plugin lets you make three of the most common edits to Genesis (Post Info,
Post Meta, and the Footer) through a very easy-to-use interface with shortcodes
(i.e. WordPress shortcuts). If you want even more, you can use some simple HTML

to extend it further.
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Genesis Simple Hooks

Working with hooks can be confusing and requires some very specific php
knowledge. Genesis Simple Hooks makes it much simpler.

For example, if you need to put an AdSense code in before your post content, just

add it to the field for genesis_before_post_content. That's it.

The plugin also allows use of shortcode and php, so it can be very flexible and

powerful.

Genesis Simple Sidebars

Genesis Simple Sidebars lets you create new sidebars and replace either the

Primary or Secondary sidebar on each page, post, tag, or category of your site.

This is great if you need different sidebar content in different parts of your site.

Genesis Simple Menus

With Simple Menus, you can create additional custom menus and replace the

secondary navigation on each page, post, category, or tag.

Genesis Simple Breadcrumbs

The ability to choose where the breadcrumbs will show is great, but there are a lot
of things you can change about the way the breadcrumbs display on your site.
Genesis Simple Breadcrumbs makes this easy. Just change the text in the

breadcrumb fields and it will change on your site.
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Genesis Nav Menu Amplified

Check out this plugin if you need a few more options on your navigation menu, like
the ability to automatically build a menu from your pages or categories, or add the

primary navigation menu extras to the secondary navigation menu

Genesis Featured Widget Amplified

This plugin takes the already great “Genesis Featured Posts” widget and kicks it up
a few notches.

Included is the ability to select more post types, use tags (or other taxonomies),
exclude by term ID, post/pagelD, and use custom fields to find and organize your
posts. You can also control image position from the widget interface. Plus,

everything is run from hooks, so you can change and extend everything.

Genesis Admin Bar Plus

Add helpful Genesis links to the admin bar so you can quickly access Genesis

settings from anywhere in your site.

Genesis Favicon Uploader

The favicon is the small image that represents your site in the address bar and
bookmark menu of most browsers. Changing this image with the “Genesis Favicon
Uploader” is as easy as uploading your image from the dashboard.
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Genesis eNews

Creates a new widget to easily add mailing lists integration to a Genesis website.
Works with FeedBurner, MailChimp, AWeber, FeedBlitz, and more.

Genesis Twitter Widget

Twitter recently killed API v1, and all developers are now required to use APl v1.1.
This is why the StudioPress team released the official Genesis Twitter Widget, as

the old Genesis Latest Tweets widget is no longer operable.

StudioPress will be supporting this plugin moving forward, ensuring that it stays

current, secure, and in working order.

And so much more...

There are so many more Genesis plugins for you to try out. Just do a search for
“Genesis” in the WordPress plugins repository and you will get 155 results (as of

this publication).

A much easier way is to just go ahead and check out our Genesis Plugins page ;-)

11.2 Helpful Links

Whether you are just getting started or want to learn more, you will find these resources
helpful.
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WordPress Resources

¢ About WordPress

e  WordPress Docs (The Codex)

e Getting Started with WordPress

* New To WordPress - Where to Start

e  WordPress Lessons

* Learn WordPress

*  WordPress.tv

*  WordPress FAQ

¢ Finding WordPress Help
*  WordPress 101

Genesis Resources

* StudioPress Tutorials - StudioPress site with tutorials for using and customizing
Genesis.
* Genesis Tutorials - This is a third party resource that is not affiliated with StudioPress.

There are a number of useful tutorials on the site.
* Genesis Explained - If you are looking for more instruction on the nuts and bolts of

Genesis, then this developer’s guide tutorial series is a great place to start.
* Genesis Plugins - The official Genesis plugins page

e Community forums - The community forums is the place for discussing projects with

other users, finding a developer to assist you, and brainstorming code with the
community. Anyone can register here.

Additional Resources for Installation & Getting Started

e http://my.studiopress.com/docs/building-child-themes/

e http://my.studiopress.com/tutorials/import-demo-content/
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Something Not Right? Here's
Some Basic Troubleshooting
Tips

12.1 Common Installation Error Messages

Genesis Not Found

The Problem: This message is triggered by activating the child theme without
Genesis being installed, or accidentally deleting Genesis (sometimes for a manual
upgrade) with the child theme already active. Either of these actions will result in an

error like this:

Warning: require_once(%path-to-wordpress%/wp-
content/themes/genesis/lib/init.php) [function.require-once]: failed to open stream:
No such file or directory in %path-to- wordpress%/wp-content/themes/%child-

theme%/functions.php on line 3

The Solution: You will need to access your site via FTP. Once there, navigate to
your site’s theme directory. This will vary by host and site setup, but it is usually
/public_html/wp-content/themes/. The error code will actually tell you exactly
where this is. Typically you will not have access to the first part of the path, but you

will have access starting around the public_html (or similar) directory.
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If you already have Genesis backed up on your computer, find that directory.
Otherwise, you will need to download the latest version of Genesis from

my.studiopress and unzip it to a directory on your computer. Make a note of where

the file is and navigate to it in your FTP client.

Make sure the directory you are about to upload is “genesis,” spelled exactly like
that, and that directly inside the directory is “style.css” (along with several other files

and directories).

If you are using FileZilla on a Windows system, right mouse click the “genesis”
directory and select to upload. On Mac you have to activate the context menu by
holding “control” when clicking, unless you have a mouse with a secondary button

or other means of accessing the context menu.

WordPress Needs Upgrade

The Problem: When a function doesn'’t exist, it is often caused by WordPress being
out of date. Always upgrade to the latest version of WordPress. Of course, the
simple upgrade isn’t available if this error happens. The error might look something
like this:

Fatal error: Call to undefined function add_theme_support() in /%path-to-wordpress
%/wp-content/themes/genesis/lib/init.php on line 17

The Solution: You will need to upgrade WordPress. Of course this can’t be done
since you can’t get to your dashboard. To get to your dashboard you will need to
access your site via FTP and navigate to the theme directory. This is usually /wp-
content/themes/. Then you need to either remove the active theme, or just move it

out of the theme directory. This disables the theme and enables the default theme.
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Once the default theme is enabled you can login, update WordPress, and put your
theme back or reinstall it (depending on if you moved or deleted the theme), then
reactivate the theme.
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And that's it!

If you have questions, login here and ask: http://my.studiopress.com/

We're always here to help!
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